Technology Assignment-Row Operations on Tl 83

When you document your steps to solving a problem, you’ll need to use mathematical symbols that are
not available on the keyboard of your computer. Some symbols like powers and subscripts and powers
can be formed by formatting regular text. However many mathematical symbols can only be created
using specialized software designed to work with Word and other word processing software.

In this class, you'll need to utilize a software package called Mathtype to create matrices. You can
download the software for free via the link in the Orientation folder. If you are working on a campus
computer, the software has already been downloaded and installed. This software is the standard
software used to create documents containing mathematical symbols.

In this technology assignment, you create a system of equations whose solution corresponds to the
number of letters in your name. Once you have created the system you’ll solve the system with the help
of your calculator and then use Mathtype or the equation editor in Word 2007 or 2010 to document
each step. The version of Mathtype that is available of free works best with Word 2003 or 2007. If you
are using Word 2007 you may use Mathtype or the equation editor in Word 2007. If you are using Word
2010, you’ll want to use its built in equation editor.

Your system of equations should have a solution in which the x-value is equal to the number of letters in
your first name and the y-value is equal to the number of letters in your last name. For instance, the

solution (X, y) = (2,1) would correspond to a person whose first name has 2 letters and last name has 1

letter.
There are many systems that could have this solution. For instance, the system
X+y=3
2x-3y =1
has the solution (X, y) = (2,1) . To check, simply substitute X =2 and Yy = linto each equation:
2+ 1=3
2(2)-3(1) =1
Since both equations are true, (X, y) = (2,1) is a solution to the system. You'll need to come up with a
system of equations that corresponds to the number of letters in your name.

Once you have your system, follow the steps below with your system to perform Gauss-Jordan
elimination on your calculator. Then use the information about Mathtype or the equation editor in
Word 2007 or 2010 to document the steps you followed. On the last page are the final instructions for
this assignment.
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Carry Out the Row Operations on a TI-84

The description below describes how to carry out row operations to solve the system of equations
above. You can also do these steps on paper without the use of a calculator.

1. To solve the system using row operations, we first need to put MATH EOIT
the system of equations into an augmented matrix. For the =g
system above, the augmented matrix is : [B] 21
1 113 S35 [C] 2H3
2 =31 o [E] 3x3
2. Turn your calculator on and press to erase anything on %_1_ EE%
the Home Screen.

3. Press to enter the MATRIX menu. This menu allows you
to refer to a matrix’s name, do math with matrices, or edit a
matrix.

4. We'll start by entering the matrix into the calculator. Use the ] | IATRI® [A] 2 =2
button to highlight EDIT. The EDIT menu allows you to enter [1 1 1
matrices of any size into matrices with names [A], [B], ect. L= i ]

5. Press to edit the matrix called [A].

6. The screen shown to the right should look similar to yours. It
indicates that matrix [A] is currently a 2 x 2 matrix (yours may
be different). It also shows the contents of the matrix below the
dimensions.

7. Since the matrix we are entering is a 2 x 3 matrix, change the MATRI®I[A] 2 =3
dimensions by pressing 2 3 [ENTER]. Notice that the matrix | |[ FllIIIN 1 0
below grows to the proper number of rows and columns as you L& i "
enter the dimensions. If you have more than 3 columnsin a
matrix, the contents of some of the columns will be off the right
side of the screen and can be accessed using the [¢], [«], (<], [+]
buttons. 121=1

Bl Bl

8. Enter each of the entries in the augmented matrix followed by MATRI®I[A] 2 =3

[ENTER]. Make sure you have written down this matrix. [1 i ]
[z - h]

za2zx=1
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Now that we have entered the matrix into the calculator, return
to the home screen by pressing MODE].

HAMES |ilMls EDIT

5.;-%!9’&':

10. Press to enter the MATRIX menu again. Trdime
11. Press [*] to move to the MATH menu in MATRIX. diFi1ll¢
ot identitac
&: Fandhc
7Jaugdment
12. This menu contains all of the commands we’ll use to do row HAMES 2 EDOIT
operations with your calculator. Use the [+] to scroll down to ElTC-L-Il'"I LM
the window shown to the right. Fl: ref i
Birref(
C:rowSwar |
0= Fowt o
E:#rowc
Frow+
13. The first command we’ll use is *row+( . Scroll down to F: *row+( | |-+ ¢
using the [+] button and press [ENTER].
14. The syntax for this command is that it requires 4 inputs. First is ® o+l =2,

a number indicating what we’ll multiply the row by. Second is
the name of the matrix. Third is the row we’ll multiply and last
is the row we’ll add to. In the case of our matrix, we'll type
*row+(-2, [A],1,2) indicating that we’ll multiply row 1 in the
matrix [A] by -2, and add that to row 2. The result will be placed
in the second row. This should put a 0 in the second row, first

column. To start this command, press [Q][2][-].

15.

16.

17.

Next we need to enter the name of the matrix, [A]. Press
to enter the MATRIX menu.

Since NAMES is highlighted and 1: [A], we can press [ENTER] to
paste [A] to the *row+( command. If you had stored your
matrix under a different name, you would scroll down to the

appropriate name and press [ENTER].
Press[.].

#ro+C 2. [A] .
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18. The next two inputs indicate the row we’ll multiply and which #ro+s -2, [Al-1,2
row we’ll add to. Press (1)L ]2]0].

19. Press to see the result of the row operation. Notice that kot -2, [Al 1.2
the entry in the second row, first column is 0 as desired.
[([1 1 31
(@ -5 -31l

20. We have completed the row operation, but now we need to #ro+s -2, [Al-1,2
save this new matrix as [A]. Press[ST0®]. This will take the
answer we just found, and store it in some location. [ EI%I ];5 -':':5} ]
A=+

21. To specify the location, press [2nd]x-[ENTER]. This will store the kot -2, [Al 1.2
new matrix in [A].
[[1 1

301
[B -5 -511
A=+ [AIN

22. Press [ENTER]. Write down this matrix so that you can include it kot -2, [Al 1.2
in the steps you’ll document using Mathtype.

|
A=+ [A]
|

e Lo e
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23. Note that we have a 1 in the first row, first column and a 0 in
the second row, first column. Now we’ll change the -5 in the A
second row, second column to a 1. To do this we’ll multiply the [[1 1 31
second row by -1/5 using the *row( command. The syntax for = =R :I: & = a1l
this is *row(-1/5,[A],2). The first input is the number you’ll F= [0l 1 I ]
multiply by. The second input is the name of the matrix. The [B -5 -5]11
last input is the ron you’ll multiply. The result will b_e placed in #pat =15, [A] .20
the row you’ll multiply. Enter the command so that it appears
like the screen on the right. You'll need to press [2nd][x-1[»] first
to get to the MATRIX MATH menu.
24. Press to carry out the command. Notice that a 1 is now A==+ [A]
in the proper place in the matrix. [ Eé‘ :|.5 35% ]
#powt 15, [A] 22
[[1 1 3]
(A 1 111

25. Store the matrix in [A] by pressing [STO®)2nd](x~"][ENTER](ENTER]. *rowt, —1-5. [Al .22
Write down this matrix so you can document this step later.
[[1 1 3]
[ 1 111
A=+ [A]
[[1 1 3]
[ 1 111
|
26. In the last row operation, we need to place a 0 in the first row,
second column. We'll do this by multiplying the second row by - [[1 1 3]
1 and add the result to the first row. Carry out this operation by a1 111
reproducing the screen to the right (look at steps 12 through A=+ [A]
19). [[1 1 3]
B8 1 111
kot -1, [Al 2.1
] |
27. Press to carry out the row operation. Notice thata O is in A==+ [A]
the proper position. Write down this matrix. It indicates that x is [[1 1 3]
equal to 2 and y is equal to 1. It matches the solution we were a2 1 111
anticipating so we have completed the Gauss-Jordan process :;:r-":"""-l-': "1, [Al-2.1
successfully. [[1 B 2]
[ 1 111
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In some instances you may want to interchange two rows of a matrix. You can do this from the MATRIX
MATH menu using the rowSwap( command. Its syntax is

rowSwap( name of matrix, first row to interchange, second row to interchange)

Typing rowSwap([A],1,2) will interchange the first and second rows in matrix [A].

Always remember to store your matrix using the button as you work through the process.
Forgetting to do this is the most common mistake students make.

Document Your Steps in Word Using Mathtype in Word 2003 or 2007

Now that we carried out the row operations on a graphing calculator, we'll document those steps using
Word 2003 or 2007 and Mathtype. You can also use the built in equation editior in Word 2007 or 2010
to carry out these steps. The instructions for using the equation editor in Word 2003 or 2010 are shown
on later pages of this document.

We want to explain the steps like what we see below:
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Step 1: Write down the system of equations.

X+y=3
2x-3y =1

Step 2: Write down the corresponding system of equations.

1 1.3
|
2 31
Step 3: Multiply the first row by -2, add it to the second row and place the result in the second row or

(-2 R1+R2>R2).
1 1.3
|
0 -5!-5

Step 4: Multiply the second row by -1/5 and place the result in the second row (-1/5 R2 > R2).

113
|
011

Step 5: Multiply the second row by -1, add the result to the first row and place the sum in the first row

(-1R2 + R1 > R1).
1 02
|
0 11

Step 6: Read the solution from the augmented matrix, X=2 and y =1.

In the steps below, you’ll learn how to enter a system of equations (as in step 1), an augmented matrix
(as in steps 2 through 5) and an equation on a line (as in step 6) into Word.

Create a System of Equations in Mathtype

1. Start Word 2003 or 2007.

1. Along the top of Word 2007 you'll see a series of tabs. If Mathtype has been successfully installed,
you’ll see a Mathtype tab. Left click on the Mathtype tab. In Word 2003 you’ll see a menu item
called Mathtype. Click on the tab or menu item.

—L-J-"’l Home Insert Page Layout References Mailings Review View MathType Acroba
¥ Inline 22 Math ~ (1) Insert Number - t Previous 8.2 Equation Preferences
E Display £2 Other~ || &) Insert Reference @ | Equations - || ®% Format Equations
E Right-numbered - ;1 Chapters & Sections ~ ¥ MNext Ei. Convert Equations

Insert Equations Symbaols Equation Mumbers Browse Format

This panel contains all of the commands to start Mathtype or insert basic symbols. On the right side
is the Insert Equations part of the panel. You can insert an equation within a sentence by left clicking
on Inline. You can insert an equation on a line by itself by left clicking Display. You can even insert
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equations labeled with numbers on the right by left clicking on Right-numbered.

The Symbols part of the panel allows you to type Greek letters like a, B or mathematical symbols
like =, oo, or =+.

Since we want to create the system of equation on its own line, type some descriptive text (like in
Step 1) and then left click Display.

JL=IE

File Edit Wiew Format 3Skyle Size  Preferences  Help

szl jab | wEE| £e®@ | 22l 73| Enc || Qeod | AwB | AOQ®
GH| 243 £ 2| 2oz Js == 10 0| o ||
Bl |co|la|—=al=|=|2|@IE|E 2|20 e 2] 2
Derivs Statistics Ivigtrices Sets Trig Geomet Tab & Tab 4

T3 i T i 1
@t + b LE)E b - dac Iz Hin-rl 3
zx |r s [uo|-[@|e]a]om]e|a]

- BHEEE

|D 1 1 1 ! 1 1 1 ll 1 1 1 ! 1 1 1 12 1 1 1 ! 1 1

=

.« ol

| Style: Math | Size: Full |Zoom: 200%  |[Color: 4

A Mathtype window like the one above will appear. This is the window we’ll use to create equations,
matrices and other mathematical creations.
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Our system of equations is not too complicated and can be created using the buttons on the
keyboard. More complicated expressions we’ll require the use of the buttons you see in the top of
the Mathtype window. Use your keyboard to type in the first equation of your system. The =
usually in the upper right hand corner of your keyboard.

o x|
File Edit Wiew Format Style Size  Preferences  Help
; o L
Zzx| jab | FEE| 2@ | 2= Awl | anel [
EE| 24T 25| Zazs 0§ oo $288 ||
R(O|coles|—=|a]|=|=|L|E]|E 3
Dlerivs Statistics hiatrices Sets Trig Geomeat| Tab & Tab &
! 1
7| lim -at«,’a?-w T
Jat 4 b s Bt - dac Afn=r]
Iz |11: |F |5 |m |9;rr|—o|®|@|{:l| t:>|[°1]|oo|=."_|
1 | 1 | 1 1 | 1 12 1 | 1 1 |
X+ y=
kil ;I_I
| Style: Math | Size: Full |Zoom: 200%  |[Color: 1 v

4. To start your second equation on a new line, press the Enter key on your keyboard.

5. Type the second equation in your system of equations.

¥ MathType - Untitled 1 =1oj x|
U

File Edit VYiew Format Stvle Size  Preferences Help

<zz= | iab | ¥EE| 2@ | 2=l 73| Enc | dccf | AwA | AO®
E| 4z | &0 |zozn 8 s == I U | o 38|
o S N P O T e 0 O S R g
Derivs Statistics hatrices Sets Trig Geormet Tab & . Tab 9
) 5 -e-t.f?- n! 1
e} +f:'2 ]J'rg;lg B - dac r'(n :")
Z |11 |F |5 |2L |93T|—a|®|{£‘-| ~<1| bl[ﬂlllmlfl
| 1 1 ! 1 1 1 ! 1 1 1 !2 1 1 1 ! 1 1

x+y=3
2x—=3y=1

4]

| Style: Math [ Size: Full |Zoom: 200%  [Color: N v
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This system would look much nicer if the —_
equations were aligned along the = sign. To || Aol Style Size Preferences Help
do this, left click on the Format menu along . v Align Left Cr+-Shift+L .
the top of the window. = Align Center Ckrl+5hift+3

Align Right Chrl+Shift+R

line up along the = as desired.

Select Align at =. Notice that your equations w )
Align at .
I

The system of equations is complete. To File Edit Wew Format Style Size  Preferences He
paste this equation into your document, left New Chl+M
click on the File menu along the top of the Open... CtHO
window. Close and Return ko Document2 h Chrl4+F4
Ipdate Documentz Chel+5
Select Close and Return to ???? where ???? Save Copy &s..,
is the name of your Word document. _
Prinit. .. CErl+P
. You should now see the system of equations Exit Alk+F4

on a separate line in your document. .
1 I, gif

2 2L wideohchet ¥ skuff, aif

3 C:1dodocsiHarsh Project) Testitest 1, gif
_—_—
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Create an Augmented Matrix with Mathtype

1. Start Word 2003 or 2007.
2. Along the top of Word 2007 you'll see a series of tabs. If Mathtype has been successfully installed,
you’ll see a Mathtype tab. Left click on the Mathtype tab. In Word 2003 you’ll see a menu item

called Mathtype. Click on the tab or menu item.

2. Type some descriptive text (like in Step 2) and then left click Display.

S MathType - Untitled 1 =10l x|

File Edit W%iew Formak Style Size  Preferences  Help i

wz=| jab | gEE| £+e® | 2=l ¥3)| gEncS | Acef | AwB | AD®

|||l |—=|al| ||| 6|2 |2 ¥ el £
Derivs Statistics higtrices Sets Trig Geomet| Tab & Tab 4
3 T nl 1
e | M| e | 207 sy |
z|x |F |8 |a|m|—=|=]|®]a]b=]|bk]]c]2 .
I - [EE ] 1
|D'"I'"l'"I'"11"'|"'1"'|"'12"I';"

r=a "‘I
e
H

Lad

«l o

| Style: bath | Size: Full |Zoom: 200% | Color: N i

3. To start your matrix, create a set of brackets

from the third row of [L]

by selecting
buttons.

4. To create the matrix entries inside of the
brackets, select =L from the second
row of buttons.

5. Select the lower right hand sub-button to
create a variable sized matrix. Other buttons
create matrices with specific sizes.
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6. A box will appear that allows you to enter the number of rows and columns. Enter 2 for rows and 3

for columns as shown below.

a a a

™ Equal calurmn widths 0k
F o IE Column alignrment;

I Colurmns; |3_ " Left

% Center
™ Right

kol

a a

=
=

A= Cancel L

At Help

ddip

¢ I Egual row heights
¢ Row alignment:
e O Top
i ¥ Bazeline
" Battam
Click between the
elements to add or
change partition lines.

Clear all lines |

7. You can left click between the rows and columns to create solid lines or dashed lines between the
rows or columns. Put a dashed or solid line between the second and third columns. You may have to
click between the columns more than once to get the type of line you want.

8. Enter the values for your augnmented matrix o,
by clicking your mouse in a space and typing
the number. |

1 1 '3
I
I
2 31
al

9. The augmented matrix is complete. To paste File Edit ‘iew Format Style Size  Preferences He
this equation into your document, left click on New ChHM
the File menu along the top of the window. Open... ChO

Close and Return to Document2 Crl+F4

10. Select Close and Return to ???? where ???? is Update Document2 k 5
the name of your Word document. Save Copy As, ..

. Prink... ChrlHP

11. You should now see the augmented matrix on i ' L
a separate line in your document. Exit alk+Fd

1 Ire. qif
2 L A videoicha i stufF . gif

3 Ci\dgdocs\Harsh Project! Test\test 1. gif
—_—
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Create an Equation within a Sentence with Mathtype

3. Start Word 2003 or 2007.
4. Along the top of Word 2007 you’ll see a series
of tabs. If Mathtype has been successfully — nue e
installed, you'll see a Mathtype tab. Left click . Inline
on the Mathtype tab. In Word 2003 you'll see a —
menu item called Mathtype. Click on the tab or Z D”p'&
menu item. E Right-numbered ~
Insert Equations
5. Toinsert an equation within a line like in step
6, type some descriptive text. When you get to
the point where you would like to insert your
equation, left click on Inline.
6. Use your keyboard to type the equation, x = 2. T-T'H"'Ii”'
12. When the equation is complete, paste this Iﬁ Edit Wiew Format Style Size  Preferences He
equation into your document. Left click on the New N
File menu along the top of the window. Open... Chrlao
Close and Return ko Docurment2 Ctrl4+F4
13. Select Close and Return to ???? where ???? is Update Document2 k Chrl+5
the name of your Word document. Save Copy &s...
14. You should now see the equation within the Frin.. Cul+P I
sentence in your document. Exit AlE+F4
1 I, gif .

2 2 wideohcheyskaff, aif
3 ChdodocsiHarsh Project) Testibest1a, gif

_—

Using the techniques outlined above, create a Word document and document the steps you used to

solve your system of equations. Use the steps in the box above (steps 1 through 6) as a guide as to how

your document should look.

Once you have documented your steps, save your document and turn it in using the link available

online. Be sure to include your name, class and date in the document.
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Document Your Steps in Word Using the Equation Editor in Word 2007 or 2010

We want to document the steps of solving the system of equations like is shown in the box below.

Step 1: Write down the system of equations.

x+y=3
2x—3y=1

Step 2: Write down the corresponding system of equations.
[1 1 3]
2 -3 1

Step 3: Multiply the first row by -2, add it to the second row and place the result in the second row or

(-2 R1+R2>R2).
1 1 3
o 25 sl

Step 4: Multiply the second row by -1/5 and place the result in the second row (-1/5 R2 > R2).

o 1 1

Step 5: Multiply the second row by -1, add the result to the first row and place the sum in the first row
(-1R2 + R1 > R1).

[1 0 2

0 1 1

Step 6: Read the solution from the augmented matrix, x = 2 and y = 1.

In the steps below, you’ll learn how to enter a system of equations (as in step 1), an augmented matrix
(as in steps 2 through 5) and an equation on a line (as in step 6).

Create a System of Equations with the Equation Editor in Word 2007 or 2010

1. Start Word 2007 or 2010.

2. Click on the Insert tab. on the right hand side of n Q
the window is a panel containing the equation
editor button titled Equation. This is the button Equation Symbal

we use to create equations, systems of equations,
and matrices. The Symbol button is used to
create individual symbols like  and a.

Symbols
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Since we want to create the system of equation
on its own line, type some descriptive text (like in
Step 1) and then press Enter to place the
insertion point on a line in the document.

Press the Equation button to begin the system of
equations.

| Type equation here.

Our system of equations can be created using the
Matrix button on the top of the window. To see
this button, make sure you have clicked on the
equation region.

Press the Matrix button to reveal a submenu.

10
[ul

r Matrix

-

From the Matrix submenu, locate the button
indicating two rows and one column.

Select the button with two rows and one column.
This will insert two spaces in your equation where
you may type the two equations.

R R L

10.

Select the first row by clicking the mouse in the
space there. Type the equation in that space
using the keyboard.

Now click the mouse in the second row and type
the equation for the second equation.
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11.

12.

13.

These two equations are not aligned very nicely.
Right click on one of the equations to reveal a
menu.

Towards the bottom of the menu is the option for
column alignment. Select this option to reveal
another submenu.

Select Right alignment. For this set of equations,
right alignment lines up the equal signs in the
equation. Sometimes it is also necessary to add
spaces to the equations to get the equal signs to
line up.

LLI 1]
[

second row_or
|
[ Paste
E ﬁ Professional
d €3 Linear ) > R2).
"‘I:h Save as Mew Equation...

Hide Placeholders
) Insert ¥ hin the first row
Delete b

Matrix Spacing...

Matrix Alignment b
X Column Alignment b= Left
— Align at this Character =| Center
A | Font. = Right
ﬁ Paragraph...

14.

Your system of equation is now complete. You
may click outside of the equation region to
continue editing your non-equation content in
the Word document.

lif x+y=3
2x—3y=1 ,‘

Create an Augmented Matrix with the Equation Editor in Word 2007 or 2010

1. Start Word 2007 or 2010.

2. Click on the Insert tab. on the right hand side of the window is a panel
containing the equation editor button titled Equation. This is the button n Q
we use to create equations, systems of equations, and matrices. Equation Symbal

3. Type some descriptive text (like in Step 2 through 5) and Enter on the symbaols
keyboard. Then left click the Equation button.

4. On the left side of the Word window is a bracket button.

0%

Bracket

- -
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5. When you click on the bracket button, a submenu will appear. Click on the

button shown to the right to insert the brackets in the matrix -
6. Click on the space inside the brackets to highlight that area.

B

7. Atthe top of the Word window, locate the Matrix button. Select that 10

button with the mouse. |:l'=l'1

r Matrix

8. Asubmenu will appear. Select the matrix containing two rows and three

columns.
9. Click in each of the entries in the matrix and type the entry. 11 3

. . . . . [2 -3 1]

10. Your matrix is now complete. You may click outside of the equation region

to continue editing your non-equation content in the Word document.

Create an Equation within a Sentence with the Equation Editor in Word 2007 or

2010
1. Start Word 2007 or 2010.
2. Click on the Insert tab. on the right hand side of the window is a
panel containing the equation editor button titled Equation. This "' [ Q
is the button we use to create equations, systems of equations,
and matrices. Equation Symbal
- o Symbaols
3. Type some descriptive text (like in Step 6). When you need to
insert an equation within a sentence, left click the Equation
button.
4. Use your keyboard to type the equation, x = 2.
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5. Click the mouse outside the equation region and continue typing

the sentence.
x= 2&\
6. Sometimes Word will place an equation on its own line that you = _
. L . . T | 5ave as Mew Equation...
would like to be within a sentence, To change an equation that is
displayed on its own line to an inline equation, click on the down €% Professional
arrow in the right corner of the equation region. €% Linear

Change to Inline
7. Select Change to Inline to place the equation within a sentence.

An inline equation can be set on its own line following a similar
procedure, but select Change to Display.

Justification 4

Using the techniques outlined above, create a Word document and document the steps you used to
solve your system of equations. Use the steps in the box above (steps 1 through 6) as a guide as to how
your document should look. Depending on what version of Word you are using, use Word 2003, 2007, or
2010.

Once you have documented your steps, save your document and turn it in using the link available
online. Be sure to include your name, class and date in the document.




